Notice
The information contained in this document is subject to change without notice. LI-COR MAKES NO
WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. LI-COR shall not be liable for errors contained herein or for incidental or
consequential damages in connection with the furnishing, performance, or use of this material.

This document contains proprietary information that is protected by copyright. All rights are reserved.
No part of this document may be photocopied, reproduced, or translated to another language without prior
written consent of LI-COR, Inc.

Printing History
Publication Number 984-11074

June, 2010

LI-COR, Odyssey, MPX and IRDye trademarks contained in the Software Product are trademarks or registered
trademarks of LI-COR, Inc. Third party trademarks, trade names, and product names may be trademarks or
registered trademarks of their respective owners. You may not remove or alter any trademark, trade names, product
names, logo, copyright or other proprietary notices, legends, symbols, or labels in the Software Product. This EULA
does not authorize you to use LI-COR’s or its licensors’ names or any of their respective trademarks.

LI-COR is an ISO9001 registered company. ©2010 LI-COR Inc. All rights reserved. Specifications subject to
change. LI-COR, Odyssey, FieldBrite, MPX and IRDye are trademarks or registered trademarks of LI-COR, Inc.
Odyssey Fc Imager, FieldBrite, and IRDye reagents are covered by U.S. patents, foreign equivalents, and patents
pending.
# Table of Contents

## Chapter 1: Getting Started
- Installing the Software ................................................................. 1
- Setting up a Work Area ................................................................. 1
- Connecting to the Odyssey® Fc .................................................. 1
- Using Key Tips ............................................................................. 2

## Chapter 2: System Overview
- Odyssey Fc System: Near-Infrared Fluorescence and Chemiluminescence ........................................ 3
- Odyssey Fc Detection System ...................................................... 3
- Table Format ............................................................................... 3
- Starting Scans and Analyzing Images ........................................ 4
- What’s Next? .............................................................................. 4

## Chapter 3: Acquiring an Image
- Inserting the Sample .................................................................... 5
- Acquiring the Image ..................................................................... 5
- Viewing the Image and Data ....................................................... 7

## Chapter 4: Importing an Image
- Importing an Image .................................................................... 9

## Chapter 5: Manipulating an Image
- Viewing the Image ...................................................................... 11
- Adjusting the Look of the Image ............................................... 11
- Rotating the Image .................................................................... 14
- Cropping the Image .................................................................... 15

## Chapter 6: Analyzing a Blot or Gel
- Adding and Manipulating Shapes Manually ............................... 17
- Using the Profiles ....................................................................... 20
- Subtracting the Background ...................................................... 20
- Annotating the Image ................................................................. 21
Chapter 7: Performing Western and MPX™ Western Analyses .............................................................. 23
  Applying a Western Analysis .................................................................................................................. 23
  Setting the Boundary ............................................................................................................................ 24
  Setting the Lanes ................................................................................................................................. 24
  Setting the Marker .............................................................................................................................. 26
  Finding the Bands Automatically ........................................................................................................ 27
  Editing Bands Manually ....................................................................................................................... 28
  Subtracting the Background ................................................................................................................ 29
  Reviewing the Lanes Table ................................................................................................................ 29
  Reviewing the Bands Table ................................................................................................................. 30
  Applying the MPX Western Analysis ................................................................................................. 30
  Reviewing the MPX Lanes Table ........................................................................................................ 32

Chapter 8: Working with the Tables .................................................................................................... 33
  Working in the Images Table ............................................................................................................... 33
  Adding or Deleting a Column .............................................................................................................. 34
  Editing the Image Title ......................................................................................................................... 35
  Adding Custom Columns ...................................................................................................................... 35
  Pasting Data in a Column ..................................................................................................................... 36
  Copying Data to a Spreadsheet ........................................................................................................... 37
  Sorting by Column ............................................................................................................................... 37
  Filtering the Table Manually ............................................................................................................... 38
  Defining Filters .................................................................................................................................. 38
  Viewing the Shapes Table ................................................................................................................... 39

Chapter 9: Exporting Data, Printing Images, and Generating Reports ........................................... 41
  Exporting Acquisition Data and Images .............................................................................................. 41
  Printing Images ................................................................................................................................. 42
  Generating Reports ............................................................................................................................ 43
Chapter 1: Getting Started

Installing the Software
Install the Image Studio Software and the Image Studio Odyssey® Fc Acquisition Key first. For added features, install the Image Studio Western Analysis Key. Once the software is installed, double-click the shortcut that appears on the Desktop to start the Image Studio software.

Setting up a Work Area
When starting the software for the first time, you will need to create the first Work Area. The Work Area is a folder on your hard drive or network where all of your images, analyses and settings will be stored. Click on Browse... in the Set Active Work Area menu to open a browse window where you can select a folder on your hard drive or network to use as your Work Area. This folder will now appear in the Available Work Areas window every time you open the software. Select the folder and click OK to set it as your Work Area. (To delete a Work Area, select the folder in the Available Work Areas window and press the Delete key on your keyboard.)

Note: Each user should create their own Work Area, as the settings for the instrument, analysis, image display, etc. from the last session will be applied to the next session.

Connecting to the Odyssey Fc
Once the software starts, it searches for and discovers the Odyssey Fc Imager on the same LAN automatically. If you experience connection problems, be sure that IPv6 is enabled on the computer. To manage the status of the instrument, click on the Image Studio Application button and hover over Instrument.
Using Key Tips
The keyboard can be used to access the tabs and other features of the Image Studio software by activating Key Tips. Press ALT to display the key tip badges for all ribbon tabs and the application quick launch buttons. Press the letter key next to the application quick launch buttons to select that application.

Press the letter key next to the ribbon tabs to view the ribbon for the selected tab and the key tips for the commands on that ribbon. Press the letter key next to the commands to activate the commands or open another menu.

In this tutorial, directions will be given to select the tabs and commands by clicking with the mouse. Press ALT at any time to use the Key Tips to select the tabs and commands with the keyboard.
Chapter 2: System Overview

Odyssey® Fc System: Near-Infrared Fluorescence and Chemiluminescence
The Odyssey Fc System detects IRDye® Infrared Dyes at independent wavelengths for two-color detection and quantification in the infrared. Chemiluminescent substrates can also be detected and a qualitative image acquired. Each channel is acquired sequentially. An example of the use of the infrared channels with the chemiluminescent channel is imaging a marker lane stained with Coomassie in the 700 nm channel combined with the qualitative chemiluminescent image.


Odyssey Fc Detection System
The Odyssey Fc laser module contains a 685 nm and a 785 nm laser. Image acquisition by the LI-COR CCD camera consists of images for two fluorescent probes in the 700 and 800 nm channels, as well as an image for chemiluminescent substrates in the Chemi channel (assuming all channels are enabled). In the software, acquisition of the three channels is sequential and can be selected separately or in any combination.

The quality of Odyssey Fc images is enhanced by a patented filtering system that dramatically reduces noise before detection by the CCD detector. Infrared signal detection has also been optimized for IRDye Infrared Dyes, which eliminates the need for filter selection by the user before imaging. The unique proprietary FieldBrite™ XT technology used in the Odyssey Fc Imager and developed exclusively by LI-COR acquires images without saturated pixels on the first attempt. More than six logs (22 bits) of dynamic range are available for each image with no user adjustments.

Table Format
Images acquired are referenced in a table with multiple columns that can be used to filter, sort, and select the desired images. There are a number of column descriptions which allow filtering by such things as Acquire Time, Project, or Channels. There are also three custom field columns. Images can be selected for analysis, printing, or export. Data from an analysis of the image are stored in tables with multiple descriptive columns as well. Image Studio has several options for exporting image and table data, and for generating reports.
Starting Scans and Analyzing Images
For typical scans, a blot or gel is placed on the imaging tray and inserted in the imaging drawer. The scan is started from the computer using Image Studio software. In the software, the desired channel or channels are selected, along with the length of the integration time for each channel. At the end of a scan, image data are referenced in the Images Table with multiple descriptive columns.

When a scan is complete, you can open the View ribbon to modify how the image looks on the screen. Use the Image ribbon to create a modified copy of the image. In the Analyze ribbon, shapes are manually added and used for quantitation. The Annotation ribbon is used to add text and arrows to the image. Installing the Western Key adds the Western Analysis and MPX Analysis ribbons. These applications have enhanced features for adding lanes, bands, and markers to a Western or MPX™ Western blot.

What’s Next?
In Chapters 3 and 4, you will learn how to acquire and import images. Manipulating and analyzing an image is covered in Chapters 5 and 6. The Western Key application is discussed in Chapter 7, followed by instructions on working with the Tables in Chapter 8. In the final chapter, you will export and print the image and data, as well as generate a report.
Chapter 3: Acquiring an Image

Before starting, check that the instrument is turned on and that the Image Studio software with the Western Key is running and connected to the instrument.

Inserting the Sample
The first step is to insert a sample into the instrument. For the Tutorial, you will image the field installation target.

1) Open the imaging drawer by pressing the Imaging Drawer open/close button.
2) For this exercise, place the field installation target that comes with the Odyssey® Fc instrument in the imaging drawer by aligning the notches in the target with the guide pins in the drawer.

Note: Do not use the imaging tray for placing the field installation target in the instrument.

3) Press the Imaging Drawer open/close button again to close the drawer.

Note: Techniques for placing Western blots or gels in an imaging tray to insert in the instrument are given in the Odyssey Fc Operator’s Manual.

Acquiring the Image
1) To acquire an image, first click on the Acquire tab to show the Acquire ribbon.
2) Hover over the first group to learn the status of the instrument. Right now, it should say Ready, indicating the instrument is connected and not currently acquiring an image.

3) In the Analyze Type group, select None for this exercise.
4) In the Channels group, click the check boxes beside each channel (700, 800, and Chemi) so that a check mark appears, indicating each channel is selected for image acquisition.
5) Select 0.5 minutes as the Integration Time for each channel by dragging the slider to 0.5 in each channel.

Note: In the Standard mode, only the shown times can be selected. To select an integration time that is not shown, click on the Expand Button at the end of the Channels bar to open the Integration Time menu. Click on Expanded to change the Sliders Mode. Click and drag each Slider to select specific Integration Times.

Note: Increasing the Integration Time will decrease the background noise and increase the signal-to-noise ratio.

6) Once the parameters have been set, click on Acquire Image to start the acquisition.

Note: The instrument acquires each channel separately. The Status group provides information on the imaging process.

7) If the acquisition needs to be stopped, click on Stop Acquiring. All existing and pending channel images are discarded.
Viewing the Image and Data

When the acquisition is complete, the image will appear on the screen. The image data will appear in the table below in the Images Table. Change the Image Name to ‘Tutorial’ to easily find the image later.

1) Double-click on the cell under **Image Name** so that a cursor appears.
2) Key in ‘Field Target’ where the cursor appears. Press Enter on the keyboard when complete.
3) To view the image as it appears here,
   a. Drag the middle dot in the Image LUTs to set K equal to 0 for the 800 and Chemi channels.
   b. Adjust the max and min of the 700 channel by dragging the left and right dots to include all the pixels.
   c. Refer to Chapter 5: Manipulating an Image for complete information on adjusting the look of the image.
Chapter 4: Importing an Image

In Chapter 3, an image of the field installation target was acquired instead of a real Western blot or a gel for the purpose of the Tutorial. In this chapter, an image of a Western blot will be imported into your Work Area to use as an example for the next chapters.

Importing an Image

The image needed for this tutorial is located on the Image Studio CD in a directory called Image Examples. The file name is ‘9999999_01’.

1) To import the image, click on the Application Menu Button and move the mouse to hover over Import. Click on Copy From (Import Acquisition) in the Import menu.

![Importing Image Interface]

Note: Images from the Odyssey Imager can be imported into Image Studio software for analysis by clicking on Import > Odyssey Image.

2) Click once on the folder ‘9999999_01’ to select it. Click Open to display the image.
3) The image will open in the window and the file will appear in the Table.
Chapter 5: Manipulating an Image

Viewing the Image

1) Click on the View ribbon tab to show the View ribbon.

2) To increase and decrease the size of the image on the screen, click on the zoom icons or scroll the mouse wheel. For the tutorial, click on Restore to automatically fit the image to the window.

3) Select Single in the View Mode group to view and analyze a single image.

Note: Analysis cannot be done if the Multiple Images icon is selected.

4) In the Show group, click on all the boxes to show a check mark, indicating all items will appear on the image. To specify the location of the labels, click on the Expand button to open the Image View Label Locations menu.

Adjusting the Look of the Image

The Look Up Tables or LUTs show the histograms of the pixel intensities for each channel acquired for the image. The LUTs are on the right side of the screen.

1) Click once on the Image LUTs tab to view the histograms. To hide this view, click once on the Expand button.
2) For the tutorial, the default red and green color scheme will be used. To select a different color scheme for each channel or to disable a specific channel, click once on the appropriate colored button above the graph.

**Note:** Multiple channels can be viewed, printed, and exported in gray scale.
3) To adjust the intensity of the image,
   a. Click the *Auto Adjust* button under each graph to automatically set the min and max
      points of the display mapping.
   b. Click and drag the left (min) dot on each graph to adjust the lower threshold of pixel
      values that will shade to the same color on the viewed image. Shading the lower
      intensity pixels to the same color will visually create a cleaner background on the
      image.

   **Note:** *Changing the visual image will not change the data collected for that image or the
   quantification of that data. It only changes the mapping of raw image pixels to display pixels.*

   c. The right (max) dot on each graph can be left at the auto adjusted value. It adjusts
      the upper threshold of pixel values that will shade to the same color on the viewed
      image.
   d. Click and drag the middle dot on each graph vertically to change the K value.

   **Note:** *Further explanation of the K value can be found in the on-line Help system by clicking the
   question mark in the upper right hand corner of the screen.*
The image should now look similar to this one.

![Image](image_url)

## Rotating the Image

1. Click on the **Image** ribbon tab to show the **Image** ribbon.

2. Click on the **Rotate or Flip** icon to display the **Rotate or Flip Options** menu.

3. Select **Original** by moving the mouse to the thumbnail and clicking once on the highlighted box.

*Note: A new image is created in the desired format and a new file for that image appears in the Table.*
Cropping the Image

1) To crop the image, first click on the box next to **Apply** so that a check mark appears in the check box. Small marks indicating the corners of the cropped area appear on the image.

*Note: These small marks will not appear on the image when it is in gray scale. For cropping, change the color of the image.*

2) Next, click on **Modify** to open the *Edit Image Crop Marks* menu. Two boxes appear on the image in dotted lines.

3) Click and drag the small box in the middle of the image to center the crop marks. Click and drag the corners of the large box to surround all of the marker and bands.

4) Click on **Current Image** to mark this image with these crop marks and click **OK**. Small crop marks indicating the corners of the cropped area appear on the image at the new location.

*Note: If Images in images table is selected, this crop area is applied to all images in the Images Table.*
Note: These small crop marks will appear on the image as long as **Apply** has a check mark by it. The crop area will be applied to any print or export action. To remove the small crop marks and print or export the full image, click **Apply** to remove the check mark.

5) To create a new image of the cropped area, click **Crop**.

6) The cropped image appears in the window and a new file for that image appears in the Table. Click **OK** in the **Crop Image Completed Successfully** box.
Adding and Manipulating Shapes Manually

1) Click on the Analyze tab to open the Analyze ribbon.

2) To manually add shapes to the image, only one channel can be selected. Click on the Don’t show this channel thumbnail in the Image LUTs for the 700 channel, leaving only the 800 channel on the image.

3) Click on Auto Add Rectangle to add a rectangle to the image or Auto Add Ellipse to add an ellipse. Click on the image to place the rectangle or ellipse around a band. After adding the desired shapes, click on Select or press the Esc key on your keyboard to return the cursor to the selection tool.

4) To move or resize a shape, first select the shape by clicking on it once. Dotted lines indicate the shape is selected.
   a. To move the shape, click and drag the four-pointed cursor that appears on the shape.
b. To resize the shape, hover with the mouse over any corner or side of the shape. Click and drag the double-sided yellow arrow to make the shape bigger or smaller.

*Note:* To find the double-sided yellow arrow, the cursor must be on the selection tool (click on Select in the Shapes group or push the Esc key on your keyboard).

c. To view the shapes and labels on the image, click on **Shapes** and **Labels** in the View ribbon Show group so that check marks appear in the boxes next to them. Or, remove the check marks to remove them from the image. Refer to Chapter 5: Manipulating an Image.

d. To edit the label, click on the **Shapes** tab at the bottom of the screen to view the Shapes Table. Under the column Name, double-click on the cell for this shape and edit the text. Press Enter on the keyboard and the new text will appear on the image. To change the location of the label, refer to Chapter 5: Manipulating an Image.

*Note:* Shapes can be manually drawn by selecting **Draw Rectangle**, **Draw Ellipse**, or **Draw Freehand**. Click and drag the mouse to create the shape. The resulting shape can be moved or resized in the same ways as an auto shape.

5) To copy the same shapes to the 700 Channel,
a. Click **Select All** in the *Edit* group to select the shapes. Dotted lines indicate the shapes are selected.

b. Click on **Duplicate** in the *Edit* group or right-click on the image and select **Duplicate** from the right-click menu.

c. Click on the **Show this Channel in Red** thumbnail for the 700 channel to see the bands.

![Right-click menu]

6) To copy shapes in the 800 channel...
   a. Click on the **Don’t show this channel** thumbnail for the 700 channel, leaving only the 800 channel on the image.
   b. Click and drag a rectangle around the shapes to select them. Dotted lines indicate the shapes are selected.
   c. Click on **Copy** in the *Edit* group or right-click on the image and select **Copy** from the right-click menu.
   d. Click on the image and click on **Paste** in the *Edit* group or right-click on the image and select **Paste** from the right-click menu.
   e. To move the shapes, click and drag the four-pointed cursor that appears on either shape. The selected shapes move together.

![Shapes]

7) To rotate the shapes in the 800 channel...
   a. Click on the **Don’t show this channel** thumbnail for the 700 channel, leaving only the 800 channel on the image.
   b. Click and drag a rectangle around the shapes to select them. Dotted lines indicate the shapes are selected.
   c. Click on **Rotate** in the *Edit* group or right-click on the image and select **Rotate** from the right-click menu.
   d. Click and drag the mouse in the circle to rotate the selected shapes.

*Note: Shapes can also be rotated by selecting them and using the mouse scroll.*
Using the Profiles

1) Select ‘Shape 2’ by clicking on the shape with the selection arrow until it is a dashed line.
2) On the right side of the screen, click on the Profiles tab to view two graphs of the pixels in a selected shape. The top graph is a cross section of the pixel intensities from top to bottom. The bottom graph is a cross section of the pixel intensities from left to right.

3) Using what you’ve learned from Adding and Manipulating Shapes Manually in this chapter, adjust the size or location of ‘Shape 2’. Notice how the graph changes.

Note: The small black marks indicate the boundaries of the shape. Move the shape around the band so that the small black marks are close to the edges of the peak to capture the entire signal for that band.

Subtracting the Background

To obtain consistent data, subtract the background of the gel or blot from the shapes.

1) Click on Define Type in the Background group to view the Background Method menu.
2) Click on **Average** to subtract the average value of the pixels in the background segment. Set the **Border Width** to **3**.

**Note:** Select **Median** for the Background Method to subtract the median value of the pixels in the background segment. This method may be useful if the pixel intensities in the background segment are not uniform.

3) Click on **Right/Left** to select the segments on the left and right sides of the shape. Other options include selecting the top and bottom sides of the shape or all sides of the shape.

4) Click on **Save** to use these settings. A confirmation message will appear if the background method is changed. Click on **Yes** to change the settings.

**Note:** The black line in the Profiles indicates the background that will be subtracted.

### Subtracting a User-Defined Background

A region of the image can be chosen for the background.

1) Using what you’ve learned from *Adding and Manipulating Shapes Manually* in this chapter, place a shape on the image in the region that you choose as the background.

2) Select the shape by clicking on it with the selection arrow until it is a dashed line.

3) Click on **Assign Shape** in the Background group. A confirmation message will appear if the background method is changed. Click on **Yes** to change the settings.

---

### Annotating the Image

1) Click on the **Annotation** tab to open the Annotation ribbon.

2) Click on **Add** to change the cursor to the white text tool. Click anywhere on the image to add text or an arrow at that location. The **Text Properties** menu appears.

3) Click on **Text** or **Text with border** in the Text Properties menu to add the text inserted in the Text: box to the image. Click on **Arrow** to add an arrow to the image.
4) Click on Select or press the Esc key on the keyboard to return the cursor to the selection tool.
5) Click on the text or arrow that was added to the image with the selection tool. A dashed box appears around the text or the arrow becomes a dashed line.
6) Use the tools in the Font group to change the look of the text or arrow.

7) Click on Rotate CW or Rotate CCW in the Text group to turn the text or arrow.
8) Click on Edit in the Text group to view the Text Properties menu for the selected item. Insert a different text or change the text to an arrow in this menu.
9) If the selected item is an arrow, click on Increase or Decrease Length in the Arrow group to change the length of the arrow. Change the Font size to change the size of the arrow.
Chapter 7: Performing Western and MPX™ Western Analyses

*Install the Image Studio Western Analysis Key to access the Western Analysis and MPX Western Analysis ribbons. These ribbons have added features for quickly analyzing Westerns and MPX Westerns.*

**Applying a Western Analysis**

1) Return to the adjusted Western image from Chapter 5: Manipulating an Image by clicking on the appropriate row in the *Images Table*. To quickly find this image, hover the mouse over the Images Table to view a small picture of the image contained in each row.

2) Click on the *Analyze* tab to view the *Analyze* ribbon.

3) Click on *New Western* to access the *Western Analysis* ribbon and apply the Western analysis to the image.

*Note: To apply the Western Analysis automatically after image acquisition, click on *Western* in the Analyze Type group on the Acquire ribbon when starting the acquisition.*
Settings from the last Western analysis in your Work Area will be applied to the image.

**Setting the Boundary**

*The Boundary is the outside box that surrounds the lanes and bands on the image.*

1) To view the Boundary on the image, click on **Boundary** in the **Show** group so that a check mark appears in the box next to it. To hide the Boundary, click to remove the check mark.

2) To select the Boundary, click on it once. The line is now dashed indicating it can be adjusted.

3) To adjust the applied boundary, hover over the corners or the midpoints of the sides to view a double-sided arrow. Click and drag the arrow to move the corner or side.

4) To move the entire Boundary, click and drag the four-pointed cursor that appears anywhere inside the Boundary.

5) To draw a new Boundary, click on **Redraw Boundary** in the **Lanes** group. Click and drag a rectangle shape on the image. Repeat the above steps to adjust the Boundary.

6) To set the Boundary, click on a different spot on the screen. The Boundary line is now solid.

**Setting the Lanes**

*The Lanes are vertical lines that transect the bands in a lane.*

1) To view the Lanes on the image, click on **Lanes** in the **Show** group so that a check mark appears in the box next to it. To hide the Lanes, click to remove the check mark.

2) Count the total number of lanes in the image (including empty lanes). Adjust the **Number** in the **Lanes** group to match the total number of lanes in the image by clicking on the up and down arrows next to the box.
**Note:** The Lanes are labeled with ‘L’ plus a number, starting with ‘01’ on the left. To view the labels, click on **Labels** in the **Show** group so that a check mark appears in the box next to it. To hide the labels, click to remove the check mark.

3) To easily adjust the Lanes to transect the image lanes, use the steps in **Setting the Boundary** to adjust the sides of the Boundary.

**Note:** The Lanes are anchored to the Boundary at the top and bottom of the Lane. Adjusting the Boundary also adjusts the Lanes.

4) To further adjust a single Lane, click on it once so that the line appears dashed. Click and drag the small solid boxes at the top and bottom of the Lane along the Boundary.

**Note:** The Lanes only need to be close to the centers of the bands, as they will be optimally adjusted by the software during band finding.
5) To set the Lane, click on a different spot on the screen. The Lane line is now solid.

**Setting the Marker**

*Each Marker Lane is designated by ‘M’ followed by 1, 2, or 3.*

1) Click on the Select Marker Lanes Set icon in the Marker Lanes group and choose **One-Color Protein** from the pull-down menu.
2) Click on the Number of Marker Lanes icon in the Marker Lanes group and select **One** from the pull-down menu.
3) To change the location of the Marker Lane, click on the Marker Handle to change the rectangle to a dashed line.

**Note:** The Marker Handle is a rectangle with ‘M1’, ‘M2’, or ‘M3’ inside. It designates the lane adjacent to its left side as a marker lane. To view the Marker Handle, click on Marker Handle in the Show group so that a check mark appears in the box next to it. To hide the Marker Handle, click to remove the check mark.

4) Click and drag the four-pointed cursor on the Marker Handle over any lane to make that lane the Marker. For the tutorial, drag the cursor to the first lane to make it the Marker. The name of the lane changes to ‘M1’ and the other lanes are renumbered to exclude that lane.

5) Click on **Review** in the Marker Lanes group to see the assigned values for the bands in the One-Color Protein Marker. Click **OK** to close the box.

**Creating a New Marker**

1) Click on the expand button on the Marker Lanes group to open the Create New or Delete Marker menu.
2) Click on New… to open the Name Marker menu. Enter a name for the Marker in the box and click OK. The New Marker menu will open.

3) Click on Add to open the Add Band Value menu. Enter a numerical value for a Marker band in the box and click OK.

4) Repeat step 3 to add all of the values for the bands in the Marker. The numerical values will be sorted automatically from high to low. To delete a value, click on the value to select it and click on Delete.

5) Click on the down arrow next to Units to view the pull-down menu. Click on the desired units from the options shown.

6) In the Channels group, click on Add to view the Channel Name menu. Enter 700, 800, or Chemi and click OK. Repeat to enter multiple channels. To delete an entry, click on the entry to select it and click on Delete.

7) Click OK to close the New Marker menu.

**Note:** The name of the new Marker will appear in the Select Marker Lanes Set pull-down menu in the Marker Lanes group. Select the Marker from the menu and click on Review to see the details. Click on the expand button on the Marker Lanes group to open the Create New or Delete Marker menu and click on Delete to remove the Marker.

**Finding the Bands Automatically**

*Bands will be found in all channels.*

1) In the Bands group, click on Find to automatically find bands on the Lanes.

**Note:** Removing the Labels makes the Bands easier to see. Click on Labels in the Show group to remove the check mark next to it.

2) Click on Fewer to decrease the sensitivity resulting in fewer Bands. Click on More to increase the sensitivity and find more Bands.
Editing Bands Manually

*Only one channel may be selected to edit Bands manually.*

1) To manually edit the Bands, **only one channel can be selected.** Click on the *Don’t show this channel* thumbnail for the 800 channel, leaving only the 700 channel on the image.

2) To manually add a Band,
   a. Click once on **Add** in the Bands group and then click once on a Lane to place the Band.
   b. Click on **Select** or press the *Esc* key on the keyboard to return the cursor to the selection tool.

3) To manually delete a Band,
   a. Select the Band by clicking on it once with the selection tool. Dotted lines indicate the Band is selected.
   b. Press **Ctrl+X** or the *Delete* key on the keyboard (or right-click and select **Cut** or **Delete**) to delete the selected Band.

   **Note:** *Multiple Bands can be deleted or moved at one time.* Select multiple Bands by pressing the Ctrl key on the keyboard and clicking once on each Band or use the selection tool to click and drag a rectangle over the Bands.

4) To move a Band,
   a. Select the Band by clicking on it once with the selection tool. Dotted lines indicate the Band is selected.
   b. Click and drag the four-pointed cursor that appears on the selected Band.

   **Note:** *The Band is anchored to the Lane it appears on and cannot be moved to another Lane.*

5) To resize a Band,
   a. Select the Band by clicking on it once with the selection tool. Dotted lines indicate the Band is selected.
   b. Hover with the mouse over any side of the Band. Click and drag the double-sided arrow to make the selected Band bigger or smaller.

6) To merge Bands,
a. Use the selection tool to click and drag a rectangle over two or more Bands that appear on the same Lane, or press Ctrl on the keyboard and click once on each Band. Dotted lines indicate the Bands are selected.

b. Click on **Merge** in the **Band** group. One Band now surrounds the area in and between the previous Bands.

**Subtracting the Background**

*To obtain consistent data, subtract the background of the blot from the Bands.*

1) Click on **Lane** in the **Background** group to subtract the mean background in the Lane from the Bands that appear on that Lane.

**Note:** **Lane** *is the recommended setting for background subtraction in the Western Analysis application.*

2) To define a different background subtraction, click on **Other** in the **Background** group to enable the **Western Define Type** icon.

3) Click on **Western Define Type** to view the **Western Background** menu. Refer to **Subtracting the Background** in Chapter 6: Analyzing a Blot or Gel for more information on this menu.

**Reviewing the Lanes Table**

1) Click on the **Lanes** tab at the bottom of the screen to view the Lanes Table. The Lanes Table shows the Lanes from the current single image.

**Note:** The columns in the Lanes Table can be moved, added, deleted, or sorted in the same ways as the columns in the Images Table. The Lanes Table cannot be filtered. Refer to Chapter 8: Working with the Tables for more information.
Reviewing the Bands Table

1) Click on the **Bands** tab at the bottom of the screen to view the Bands Table. The Bands Table shows the Bands from the current single image.

![Bands Table](image)

**Note:** The columns in the Bands Table can be moved, added, deleted, or sorted in the same ways as the columns in the Images Table. The Bands Table cannot be filtered. Refer to Chapter 8: Working with the Tables for more information.

2) Notice the first 10 Bands are in the Marker Lane (M1) and the values from the selected Marker are in the column **Size**. The rest of the Bands are assigned a Size in reference to the values of the Marker Bands.

Applying the MPX™ Western Analysis

1) Import ‘MPX data.zip’ from the Image Examples folder on the Image Studio software CD. Refer to Chapter 4: Importing an Image for more information.
   a. Click on the Application Menu button and move the mouse to hover over **Import**. Click on **Copy From (Import Acquisition)** in the Import menu.
   b. Click once on the file ‘9999998_01’ to select it. Click **Open** to display the image. The file will appear in the Images Table.

2) Adjust the look of the table in the **Image LUTs** on the right side of the screen. Refer to Chapter 5: Manipulating an Image for more information.

3) Click on the **Analyze** tab to view the Analyze ribbon.

4) Click on **New MPX Western** in the Create group to open the **MPX Western Analysis** ribbon and apply the MPX Western analysis to the image.
**Note:** To apply the MPX™ Western analysis automatically after image acquisition, click on MPX Western in the Analyze Type group on the Acquire ribbon when starting the acquisition.

Parameters from the last MPX Western analysis will be applied to the image.

5) Click on Select Comb for MPX Western to open the pull-down menu. Click on **Single Marker Four Lane** to apply a template with a single marker followed by four sets of five Lanes each.

6) Adjust the Boundary so the Lanes transect the image lanes. Refer to **Setting the Boundary** in this chapter for more information.

7) Click on Select Marker Lanes Set in the Marker Lanes group to view the pull-down menu. Click on **Two-Color Protein**. Refer to **Setting the Marker** in this chapter for more information.
8) Click on **Find** in the **Bands** group to find the Bands automatically. Refer to *Finding the Bands Automatically* and *Editing Bands Manually* in this chapter for more information.

9) Click on **Lane** in the **Background** group to set the background subtraction. Refer to *Subtracting the Background* in this chapter for more information.

**Reviewing the MPX™ Lanes Table**

1) Click on MPX Lanes at the bottom of the screen to view the MPX Lanes Table.

![MPX Lanes Table](image)

**Note:** The columns in the MPX Lanes Table can be moved, added, deleted, or sorted in the same ways as the columns in the Images Table. The MPX Lanes Table cannot be filtered. Refer to *Chapter 8: Working with the Tables* for more information.
Chapter 8: Working with the Tables

Image data is stored in the folder selected as the Work Area when the Image Studio software is opened. The data is easily accessed in the Tables below the image window. In the Images Table, each row represents one image. Various fields in that row contain identifying information about the image. These fields are grouped as columns that can be moved, added, deleted, sorted, or filtered.

Working in the Images Table
1) Click on the Images tab at the bottom of the screen to show the Images Table. (Click on the Expand button to hide the Table from view.)

2) Hover with the mouse over any row to show a thumbnail picture of that image.

3) Click on any cell to select the entire row and show that image in the window.
4) Click on the corner button to select all of the images or press Ctrl+A on the keyboard.
5) Right-click any cell to view a menu with options that include copy an image, delete images, or view the properties of an image.
To move a column, click and drag the column header to the new location.

The fields in each row contain information about the image and are organized as columns across all the images. Some of the columns are properties of the image and cannot be edited. Examples of these columns include Image ID, Acquire Time, Channels, Resolution, and Instrument Name. Other columns can be edited with information for that image.

7) To edit a field, double-click on a cell so that a cursor appears. If a cursor does not appear, that field cannot be edited.
8) Add text where the cursor appears. Press Enter on the keyboard when complete.

Note: To easily find images later, enter identifying information in one or more fields after acquiring an image.

Adding or Deleting a Column
1) Click on the Table tab to view the Table ribbon.
2) Click on Add/Remove in the Columns group.

3) To add the Experiment column, click the column description to show a check mark indicating that column will be in the table.
4) To remove the Resolution column, click the column description to remove the check mark and remove that column from the table.
5) Click on **Save** to use the changes. The table now looks like this one.

![Image showing the table with modifications](image1)

**Editing the Image Title**

1) Click on the **Table** tab to view the **Table** ribbon.

2) Click on **Add/Remove** in the **Columns** group.

3) Click on **Use an additional image column with the Image ID** to place a check mark in the check box next to it.

![Image showing the editing options](image2)
4) Click on the down arrow in the selection box to choose a column to add to the Image ID to form the Image Title.
5) Click on Project. Text that is in the Project column will be added to the title of every Image.
6) Click on Save to use the changes.

Adding Custom Columns
1) Click on the Table tab to view the Table ribbon.
2) Click on the Customize icon in the Columns group to view the Custom Columns menu.

3) In the Custom Columns menu, replace Custom Field0 with Department.

4) Click on Save to use this change.
5) To add this custom column to the table, first click on the Table tab to view the Table ribbon.
6) Click on Add/Remove in the Columns group.

7) To add the Department column, click the column description to show a check mark indicating that column will be in the table.
8) Click on Save to use this change. The Department column will be added to the right of the existing columns.

Pasting Data in a Column
Use Paste in the Data group to quickly fill a column with information.

1) Double-click the first cell in the Department column so that a cursor appears in the cell.
2) Type ‘Tutorial’ at the cursor position using the keyboard.
3) Click and drag the mouse over ‘Tutorial’ to highlight it. The cursor should still appear in the cell.

4) Press \( \text{Ctrl}+\text{C} \) on the keyboard to copy the data to the clipboard.

5) Click and drag the mouse over the cells in the Department column (or press the \( \text{Ctrl} \) key while clicking each cell once) to select which cells to fill with ‘Tutorial’.

6) Click on Paste in the Data group, press \( \text{Ctrl}+\text{V} \) on the keyboard, or use the right-click menu to paste the data in the selected cells.

![Image of 'Tutorial' added to cells in Department column.]

### Pasting Data from a Spreadsheet to a Column

1) In a spreadsheet, select data and press \( \text{Ctrl}+\text{C} \) on the keyboard to copy the data to the clipboard.

2) In the Table, click and drag the mouse over the cells in the Department column (or press the \( \text{Ctrl} \) key while clicking each cell once) to select which cells in a column to place the data.

3) Click on Paste in the Data group, press \( \text{Ctrl}+\text{V} \) on the keyboard, or use the right-click menu to paste the data in the selected cells.

### Copying Data to a Spreadsheet

*Use Copy in the Data group to quickly copy rows to a spreadsheet.*

1) Click and drag the mouse over the rows or press the \( \text{Ctrl} \) key while clicking on each row once to select which rows to copy. To copy all rows, press \( \text{Ctrl}+\text{A} \) on the keyboard.

2) Click on Copy in the Data group, press \( \text{Ctrl}+\text{C} \) on the keyboard, or use the right-click menu to copy the data to the clipboard.

3) In a spreadsheet, press \( \text{Ctrl}+\text{V} \) on the keyboard to paste the data in the selected cells.

*Note: The column headings will be pasted above the data.*

### Launching a Spreadsheet

*Use Launch Spreadsheet in the Data group to open an ‘.xls’ or ‘.xlsx’ file with the selected data.*

1) Click and drag the mouse over the rows or press the \( \text{Ctrl} \) key while clicking on each row once to select which rows to copy.

2) Click on Launch Spreadsheet to open the Launch Spreadsheet browse window.

3) Select the folder destination and name the file with extension ‘.xls’ or ‘.xlsx’. Click Save.

4) An application that uses these types of files will open with the data selected and corresponding column headings.
Sorting by Column

1) To sort by any column, click once on the header. The table will be sorted by that column.

Note: No change will be made if the fields in a column are all the same.

2) To change the direction of sorting, click on the small box in the header with the up or down arrow. Or, right-click on the header and select Sort Ascending or Sort Descending.

Filtering the Table Manually

1) To manually choose images, click and drag on the rows to select the desired images. Or, select the desired images by pressing Ctrl on the keyboard and clicking once on each row.

2) Click on the Table tab to choose the Table ribbon.

3) Click on Selection to show only the selected images in the table. The Filtered/Unfiltered icon will be highlighted.

4) Click on the Filtered/Unfiltered icon to toggle between showing only the selected images and showing all images in the table.

5) To remove the filter, click on Clear All.

Defining Filters

One or more defined filters can be applied to the table to show only the images of interest.

1) Click on the Table tab to choose the Table ribbon.

2) Click on Define to view the pull-down menu of all of the column headings. Select Analysis to filter in the Analysis column.
**Note:** Right-click on any column header in the Table to access this menu for that column.

3) Deselect *None* and *Western* by clicking on the box next to them to remove the check mark.

4) Click **OK** to use this change. Only the images with *Shapes* in the *Analysis* column will appear in the Table.

**For more Filtering Options...**
1) Click on **Define Filters...** in the *Filter* menu.
2) Click on one of the filtering phrases to show the *Column Filter Analysis* menu.
3) Select filtering phrases from the pull-down menu by clicking on the down arrows next to each box or type in your own.

4) Click **OK** to use these changes.
Viewing the Shapes Table

1) Click on the **Shapes** tab in the Table to view the data for each shape.

![Shapes Tab Image]

2) The default columns are defined below.
   a. *Image ID*- Number assigned by the software to the image; a new one is assigned whenever a new image is created by cropping, copying, rotating, filtering, or analyzing.
   b. *Image Name*- Original acquisition name
   c. *Channel*- 700, 800, or Chemi
   d. *Name*- Shapes are assigned a number in sequential order. Double-click on the number in the column to edit the shape name.
   e. *Signal*- Sum of the individual pixel intensities for the shape minus the background.
   f. *Total*- Sum of the individual pixel intensities for the shape
   g. *Mean*- Mean of all pixel intensities for a shape
   h. *StdDev*- Standard deviation of all of the pixel intensities for a shape
   i. *Min*- Minimum pixel intensity for a shape
   j. *Max*- Maximum pixel intensity for a shape
   k. *Area*- Total number of pixels enclosed by a shape
   l. *Bkgnd.*- Designated background subtraction
   m. *Type*- Signal or Background

3) Move, add, delete, and sort the columns in the same way as in the **Images** Tab. The **Shapes** Tab cannot be filtered.
Chapter 9: Exporting Data, Printing Images, and Generating Reports

Exporting Acquisition Data and Images

1) In the Images Table, click on a row to select that image acquisition. To select multiple image acquisitions, click and drag over the rows or press the Ctrl key on the keyboard and click once on each row to select it.

2) Click on the Image Studio Application Button and hover over Export to view the Export image and analysis data menu.

   a. To make a copy in another folder, click on Copy To and view a choice of Backup folder or Zip File. Click on Zip File to save the image acquisition as a zip file. Either choice opens to a browse window where you can select the folder to copy to.

   b. To make a copy in another folder and delete the image acquisition from the Work Area, click on Move To (Archive) and click on Yes in the Move Selected Acquisitions menu. Select the folder to copy to in the browse window.

   c. To make an image file, click on Image to view a choice of Current Image or Selected Images in Images Table. Either choice opens to a browse window where you can select the folder to copy to as well as the file type (TIFF, PNG, or High Quality JPEG) and the resolution.

   Note: Images saved as these file types (TIFF, PNG, or High Quality JPEG) are for presentation purposes and should not be used for further analysis.

   d. To make a tiled image file of the images in the Table, click on Multiple Image View to open a browse window where you can select the folder to copy to as well as the file type (TIFF, PNG, or High Quality JPEG) and the resolution. In addition, select
Export Images Table to copy a Tab Delimited File of the Images Table to the same folder.
e. To copy a Tab Delimited File of the current Table, click on Table to view a choice of All Rows in Table or Selected Rows in Table. Either choice opens to a browse window where you can select the folder to copy to.

Note: Data can be quickly and easily exported from the Tables to an Excel spreadsheet. Refer to Copying Data to a Spreadsheet in Chapter 8: Working with the Tables.

Printing Images
1) To open the Print menu, click on the printer icon in the quick access tool bar, press Ctrl+P on the keyboard, or click on the Image Studio Application Button, hover over Print, and click on Print.

2) Click on Print to send the current image to your default printer.
Generating Reports

1) In the Print menu, click on Western Lab Book and then Print to print the default report for the current image.

2) To create a custom report,
   a. Click on Western Lab Book in the Print menu. In the right column under Lab Book Report, click on Copy.
   b. In the Specify Custom Format Print Title menu, insert ‘Tutorial’ using the keyboard and click OK. Tutorial is now a selection in the Select Print Format view.
c. Click on Edit... under Lab Book Report to see the Print Format builder menu.

**Note:** The items currently in the report appear under In Use in the left column. Items that are available to add to the report appear under Available in the right column.

d. Click once on Bands Table-Selected Bands to select it and click <Add> to add it to the In Use column. This Table will now appear in the report.

e. Click once on Bands Table-All Bands in Table to select it and click Remove> to take it out of the In Use column. This Table will not appear in the report.

f. Click once on an item in the In Use column and click Up or Down to move the item up or down in the order of the report.

g. Click Save to include the items in the In Use column in the report.

3) In the Print menu, click on Tutorial and then Print to print the custom report for the current image.